
Chapter 18

Working with Special 
Design Tools

 Learning Objectives 
After completing this chapter, you will be able to:
• Understand the concept of adaptivity and create adaptive parts
• Define parameters for creating parts
• Create standard and custom iPart factories
• Place iParts using the custom and standard iPart factories
• Create 3D Sketches
• Understand hybrid surface-solid modeling
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ADAPTIVE PARTS
Adaptive parts automatically update their adaptive features or driven dimensions based on the 
dimensions and constraints of the relative parts with which they are assembled. Note that while 
creating the adaptive parts or adaptive features, the corresponding sketch should be partially 
constrained. The missing dimension and adaptive features will then be modified based on the 
sizes, location of other components, and constraints applied between the components. You 
can remove the adaptivity of the components at any time and add the missing dimensions so 
that the parts do not change their size. To convert a feature or sketch into an adaptive feature, 
right-click on it in the Browser Bar and choose Adaptive from the shortcut menu displayed. 
Similarly, to convert a part into an adaptive part in the Assembly module, right-click on the part 
in the Browser Bar and choose Adaptive from the shortcut menu displayed. Two semicircular 
arrows pointing in counterclockwise direction will be displayed on the left of the adaptive part, 
feature, or sketch in the Browser Bar. Remember that components originally created in other 
solid modeling tools and imported to the Inventor file cannot be converted into an adaptive part.

DEFINING PARAMETERS
 Ribbon:	 Manage > Parameters > Parameters  

As mentioned earlier, every dimension in Autodesk Inventor is assigned a unique name 
termed as parameter. When you specify the value for the dimension, the dimension 
parameter is equated in an expression with the value that you specified. Autodesk 

Inventor allows you to use parameters or expressions instead of entering value while 
dimensioning a sketch. These parameters or expressions can also be entered in the edit boxes 
of a dialog box while creating a feature. You can create a new parameter by defining it in terms 
of the other parameter in an expression. The new parameters can be created before or after 
creating the sketch. You can use the Parameters tool to create new parameters. However, you 
can use this tool to control the relative position of the component in an assembly besides 
controlling the shape and size of the feature. When you invoke this tool from the Parameters 
panel, the Parameters dialog box will be displayed, refer to Figure 18-1. This dialog box has 
two types of parameters that are discussed next.

Model Parameters
Model parameters are those that are automatically created when you apply dimensions to the 
entities or when you create a feature. The model parameters are displayed in a tabular form, as 
shown in Figure 18-1. The options in this table are discussed next.

Parameter Name
The Parameter Name column displays the names of parameters. To modify the name of a 
parameter, click on its field in the Parameter Name column. The field will change to an edit box 
and you can enter the new name in it. Note that you cannot duplicate the name of parameters. 
This means you cannot have two parameters with the same name.
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Figure 18-1  The Parameters dialog box

Unit/Type
The Unit/Type column displays the unit of measuring the parameters. Note that you cannot 
modify the unit of a parameter. 

Equation
The equations are mathematical expressions in which the parameters are equated with 
the algebraic or the trigonometric functions. Autodesk Inventor allows you to define the 
parameters using the existing parameters and equations. For example, to define a parameter d2, 
you can use the equation such as d2=(d0/2+d1/2), where d0 and d1 are the existing parameters. 
However, in the d2 field of the Equation column, you will not enter “d2=”. All you need to 
enter is (d0/2+d1/2) as the equation. Since it is entered in the d2 field of the Equation column, 
Autodesk Inventor will automatically equate it with the d2 parameter.

You can also add tolerance to the parameter using the Equation column. To add tolerance, 
click on the field corresponding to the required parameter in the Equation column; the field 
changes into an edit box with an arrow on its right. Next, click on this arrow or right-click on 
the Equation field (edit box); a shortcut menu will be displayed. Choose Tolerance from this 
shortcut menu; the Tolerance dialog box will be displayed, as shown in Figure 18-2. You can 
set the tolerance parameters using the options in this dialog box.

Nominal Value
This column shows the resulting value of the equation and expressions entered in the 
equations column.
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Figure 18-2  The Tolerance dialog box

Tol.
The Tol. column is used to select the nominal, median, upper, or the lower tolerance size for the 
dimension. You can select the required tolerance size from the drop-down list that is displayed 
when you click on the field under the Tol. column.

Model Value
Generally, it is not possible for a component to be manufactured using the nominal values. 
Therefore, you need to assign some tolerance to the dimension. The Model Value column 
shows the actual value after assigning the tolerance. The value in this column depends on the 
tolerance assigned to the dimension by using the Tolerance dialog box.

Key
On selecting this check box you can designate the selected parameter as the key parameter. 
These parameters are easy to identify. You will learn more about keys later in this chapter.

Export Parameter
The Export Parameter column displays the check boxes for each parameter. If you select the 
check box of a parameter, that parameter will be added to the custom properties and can be 
displayed in the parts list.

Comment
The Comment column is used to enter some information about the selected parameter. To 
enter a comment, click on this field. The field gets changed into a text box and you can enter 
the desired comment in it.
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User Parameters
User parameters are the parameters that are defined by the user for specifying the dimensions 
of the entities and the features. To create a user-defined parameter, choose the Add Numeric 
button in the Parameters dialog box; a new row will be displayed in the User Parameters table. 
You can specify the new parameters of the user-defined parameters in the table. Note that you 
can modify the units of the user-defined parameter. To modify the units, click on the field below 
the Unit column; the Unit Type dialog box will be displayed, as shown in Figure 18-3. You can 
select the desired units from this dialog box. In addition to the Add Numeric option, there are 
two more options that can be used to create user parameters. These options are Add Text and 
Add True/False. These options can be invoked by clicking on the down arrow located on the 
right of the Add Numeric button and then choosing the required option from the flyout. These 
options work in coordination with the iLogic features of Autodesk Inventor. The options in the 
User Parameters table are similar to those discussed in the Model Parameters table.

Figure 18-3  The Unit Type dialog box

Update
Choose this button to update the feature or the model when the parameters are changed. 
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Purge Unused
Choose this button to purge the unused parameters of the model. When you choose this button, 
a list of all the unused parameters is displayed in a separate window. You can purge them in 
one operation. 

Immediate Update
This check box is selected by default. As a result, the feature or the model is updated immediately 
when the parameters are changed. If you clear this check box, you need to choose the Update 
button whenever the parameters are changed.

Link
In addition to the model parameters and the user-defined parameters, Autodesk Inventor also 
allows you to create link parameters. The link parameters are created in a separate Microsoft 
Excel spreadsheet. Note that the model parameters and the user-defined parameters can be used 
only in the current file, whereas the link parameters can be used in as many number of files as 
you require. This is because the link parameters are external parameters that can be imported 
to any file. To import a link parameter, choose the Link button; the Open dialog box will be  
displayed, as shown in Figure 18-4. You can specify the name and the location of the Microsoft 
Excel spreadsheet by using the Open dialog box.

Figure 18-4  The Open dialog box for selecting the spreadsheet

When you select the spreadsheet, its location and name are displayed in the dialog box and a 
new table is displayed. This table shows the parameters imported from the selected spreadsheet.

The following table shows a sample of the spreadsheet that can be created in order to be used 
as link parameters.
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LEN 60

LEN1 30

WID 20

HT 15

Filter
On choosing this button, a flyout will be displayed. The options in this flyout are used to limit the 
number of parameters displayed in the Parameters dialog box. You can choose the All option 
from the flyout if you want all the parameters to be displayed. If you choose the Key option, 
only the parameters that have been assigned the keys will be displayed in the Parameters dialog 
box. But if you choose the Non-Key option, only the parameters that have not been assigned 
any key will be displayed. If you choose the Renamed option, only the parameters that have 
been renamed will be displayed. If you choose the Equation option, the parameters that have 
been defined using equations or the parameters that are used to define equations are displayed 
in the Parameters dialog box.

 

WORKING WITH iPARTS
While working on assemblies, you may need to create parts having identical designs but with 
different sizes, materials, or other variables. Autodesk Inventor allows you to create these parts 
and then use them with one or more variables. These parts are called as iParts. There is a special 
technique for creating parts at the places where “collaborative engineering” has been used. 
This special technique is called iPart factories. The iPart factories can be shared by the members 
in the collaborative engineering environment to create iParts. The properties and dimensions 
of an iPart factories are saved in a table and you can use these dimensions to create an iPart in 
an assembly modeling environment.

Types of iPart Factories
In Autodesk Inventor, you can create two types of iPart factories. These are the Standard iPart 
factories and the Custom iPart factories. Both these types of iPart factories are discussed next.

Standard iPart Factories
The Standard iPart factories create iParts whose dimensions cannot be changed. This type of 
iPart factory is used to create standard parts. You can store these parts in the location of standard 
parts so that other members can also use them.

Custom iPart Factories
The Custom iPart factories create iParts with different dimensions of a part. You can specify the 
dimension of the iPart while inserting it in the assembly modeling environment.

Creating iPart Factories
 Ribbon:	 Manage > Author > Create iPart  

The iPart factories are created using the standard parts. However, it is recommended 
that the dimensions of the standard parts should be defined in terms of the model or 
user-defined parameters using the Parameters dialog box. To create the iPart factories, 
create a standard part using the parameters and then choose the Create iPart tool from 
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the Author panel of the Manage tab in the Ribbon; the iPart Author dialog box will be displayed, 
refer to Figure 18-5. The options in this dialog box are discussed next.

Parameters Tab
The options in the Parameters tab (Figure 18-5) are used to select the parameters and dimensions 
to be included in the iPart factory. When you invoke this tool, the Parameters tab becomes active. 
This tab of the iPart Author dialog box is divided into three areas. These areas are discussed next.

Part Parameters Pane
The Part Parameters pane is on the left side in the Parameters tab. This pane lists all the 
parameters and dimensions in the current part.

Selected Parameters Pane
The Selected Parameters pane is on the right of the Parameters tab. This pane lists all the 
parameters included in the iPart factory. When you invoke the iPart Author dialog box,  all 
the user-defined parameters in the current file appear on this pane automatically. You can 
remove a parameter from this pane by selecting it and then choosing the Remove (<<) 
button on the left of this pane. Once the selected parameter is removed from the iPart factory, 
you cannot modify the value related to this parameter when you create an iPart using this 
iPart factory. Similarly, you can add a parameter by selecting it from the Part Parameters 
pane and then choosing the Add (>>) button.  

Figure 18-5  The Parameters tab of the iPart Author dialog box

Assigning Keys: By assigning a key to a parameter, you can recognize the values 
assigned to the parameter. Later on, you can change the attribute values of the 
parameters that have been assigned the keys. To assign a key to a parameter, 
click on the corresponding key of the parameter in the Key column; a key of 
numeric value 1 will be assigned to the parameter and the key of that parameter 
will turn blue. The keys of the remaining parameters will be gray. To modify the 
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numeric value of the key, click on its value from the Selected Parameters pane; 
a flyout will be displayed. You can select the required key value from the flyout.

Making a Parameter Column Custom: Making a parameter column custom allows you 
to change its value while creating the iPart. To create a standard iPart factory, do not 
make any parameter column custom. However, to create a custom iPart factory, you 
need to make at least one parameter custom. To make a parameter column custom, 
first make sure no key is assigned to it. Next, right-click on it to display the shortcut 
menu. Choose Custom Parameter Column from the shortcut menu that is displayed; 
the selected parameter is made custom and the current iPart factory is made the custom 
iPart factory. Whenever you create an iPart using this factory, you can change the value 
of the custom parameter. The custom parameter column is displayed in blue in the iPart 
Table below the two list boxes in the iPart Author dialog box.

iPart Table
The iPart Table is available below the two list boxes. By default, this table has only one 
row with the default values of the parameters. The number of columns depend upon the 
number of parameters in the Selected Parameters list box. You can add rows to this table 
by right-clicking on any cell of the table and choosing Insert Row from the shortcut menu. 
A new row is added to the table. Each row in the iPart Table represents a separate iPart in 
the iPart factory. You can edit the value of the iPart parameter by clicking on its field. The 
new iPart created using this iPart factory will use the value that you specify.

Note
You can customize particular cell of the iPart Table by right-clicking on it and choosing Custom 
Parameter Cell from the shortcut menu after assigning key.

Properties Tab
The options in the Properties tab (Figure 18-6) are used to select the summary of the component, 
project properties, and physical properties. You can select a property from the File Properties 
pane on the left and add it to the Selected Properties pane on the right.

Figure 18-6  The Properties tab of the iPart Author dialog box
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Suppression Tab
The options in the Suppression tab (Figure 18-7) are used to specify whether the selected features 
will be computed or suppressed while creating a part using the iPart factory.

If you want that a feature should be suppressed when you create a part using the iPart factory, 
select it from the Model Features pane and add it to the Selected Features pane. Next, right-click 
on it and choose Custom Parameter Column from the shortcut menu displayed. The selected 
feature will be made custom and you can now specify whether the feature will be computed or 
suppressed while creating an assembly using the iPart factory. If you are selecting the Suppress  
option for a feature, it will not appear in the model. 

Figure 18-7  The Suppression tab of the iPart Author dialog box

iFeatures Tab
The options in the iFeatures tab (Figure 18-8) are used to specify the table-driven iFeatures to 
be included in the iPart table. You can specify a unique iFeature row for each iPart row of the 
included iFeature. By using the iPart table, you can control the suppression status of the iFeature. 
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Figure 18-8  The iFeatures tab of the iPart Author dialog box

iMates Tab
The iMates tab (Figure 18-9) is used to select the iMates applied to the part that will be 
included in the iPart factory. iMates are created on the parts to be assembled. Creating 
iMates allows you to assemble parts automatically in the assembly environment. The 
iMates will be displayed in the Model iMates pane if you have created them on the part. 
To include iMates in the iPart factory, select them from the Model iMates pane and 
add to the Selected iMates pane. The selected iMates will be added to the iPart factory.

Figure 18-9  The iMates tab of the iPart Author dialog box
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Work Features Tab
The options in the Work Features tab (Figure 18-10) are used to add work features to the iPart 
factory. The work features of a component include work planes, work axes, and work points. 
These work features are displayed on the left pane of the iPart Author dialog box only when 
they are created in the part. You can turn on or off the visibility of work features by selecting the 
required check boxes from the Object Visibility drop-down in the Visibility panel of the View tab. 

Threads Tab
The options in the Threads tab (Figure 18-11) are used to add the parameters related to threads 
in the iPart factory. The threads are displayed on the left pane in the iPart Author dialog box 
only if you have created them in the part. You can select threads parameters from the Thread 
definition tree and add them to the Selected Thread pane.

Figure 18-10  The Work Features tab of the iPart Author dialog box
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Figure 18-11  The Threads tab of the iPart Author dialog box

Other Tab
The options in the Other tab (Figure 18-12) are used to add other parameters to iPart factories. 
Note that these parameters cannot control the size of the part created using the iPart factory.

Figure 18-12  The Other tab of the iPart Author dialog box

To add the other parameter, click on Click here to add value and then enter the value of the 
other parameter in the text box that appears in the Name pane. You will notice that the parameter 
that you add in the Name pane is also added to the iPart Table. You can modify the value of the 
individual cells by selecting each field of the new parameter in the iPart Table.
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After setting the options in various tabs of the iPart Author dialog box, choose OK to exit the 
dialog box and to save the file. The saved file will act as the iPart factory to place the parts in 
the assembly files.

Note
When you create an iPart factory, the Table item is added to the Browser Bar. If you click on the 

 sign located on the left of the Table item in the Browser Bar, the tree view will expand and the 
parameters in the iPart factory will be displayed. 

Procedure to Create Standard iPart
	 The procedure to create standard iPart is discussed next.

1.	 Create a component in the Part environment using the parameters.  

2.	 Invoke the iPart Author dialog box by choosing the Create iPart tool from the Author 
panel of the Manage tab. By default, the Parameters tab is chosen in this dialog box. You 
can include iMates, work features, threads, and other customized properties in the part by 
using the tabs displayed in the iPart Author dialog box. 

3.	 Select the required parameter from the left pane of the iPart Author dialog box and then 
choose the Add (>>) button; the selected parameter will be added to the right pane of the 
dialog box. Repeat the same procedure in other tabs of the iPart Author dialog box to add 
the required parameters to the right pane. You can also remove parameters from the right 
pane by first selecting them and then choosing the Remove (<<) button from the dialog 
box. Using different tabs in the iPart Author dialog box, you can control the suppression 
and visibility of the created features.

4.	 Next, assign keys to the parameters that you want to identify later. You can change the values 
of the parameters that have been assigned the keys. To assign a key to a parameter, click on 
its corresponding key in the Key column.

5.	 After assigning keys, you need to add the number of rows that is equal to the number of 
iParts you want to create in the iPart Table. Add the required number of rows in the iPart 
Table and then change the parameter value in the required parameter. Note that you need 
to change the parameter values of the parameters that have been assigned the keys. The size 
of other parameters will vary according to the expressions used in defining the parameters.      

6.	 After adding the required number of rows in the iPart Table, you need to verify the table for 
errors. If there are errors in the table, they will be highlighted in yellow. Rectify the error, 
if any, found in the table.

7.	 Next, save the table by choosing OK from the iPart Author dialog box and then exit the 
part file.

Procedure to Create Custom iPart
The procedure to create the custom iPart is similar to the procedure to create standard ipart. 
To create custom iPart, perform Step 1 through Step 5 from the section Procedure of Creating 
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Standard iPart. After adding the required number of rows in the iPart Table, right-click in the 
Member column of the iPart Table; a shortcut menu will be displayed. Choose the Custom 
Parameter Column option from it. Now, you need to verify the table for errors. If there are 
errors in the table, they will be highlighted in yellow. Click on the Verify button to rectify the 
error, if any. Now, save the table by choosing the OK  button from the iPart Author dialog box 
and then exit the part file.
 

Inserting an iPart into an Assembly
You can insert an iPart into an assembly file using the Place tool. The number of iParts that 
can be inserted into the graphics window depends upon the number of rows added to the iPart 
Table. Depending on whether you select a standard iPart factory or custom iPart factory, the 
dialog box for placing the part will differ. The procedure for placing both these types of iPart 
factories is discussed next.

Placing Standard iParts in an Assembly
To place a part using the standard iPart factory, choose the Place tool from the Component panel 
of the Assemble tab; the Place Component dialog box will be displayed. Select the required 
standard iPart and choose the Open button from the Place Component dialog box; the Place 
Standard iPart dialog box will be displayed, refer to Figure 18-13. The options in the three tabs 
of this dialog box are discussed next.

Keys Tab
The Keys tab (Figure 18-13) consists of the Predefined values pane that displays the name 
and value of the parameters that were assigned the keys in the Selected Parameters pane 
of the iPart Author dialog box. Note that because it is a standard iPart, you cannot modify 
the value of any of the parameters in this dialog box. However, if more than one rows were 
created in the iPart Table, you can select the standard values from the list of available values. 
This list is displayed when you click on one of the values and select the All Values check box. 

Figure 18-13  The Keys tab of the Place Standard iPart dialog box

Tree Tab
The Tree tab (Figure 18-14) displays the name and values of the parameters  in the form of 
a tree view in the iPart Author dialog box. You can click on the + sign on the left of each 
parameter to expand the tree view.
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Figure 18-14  The Tree tab of the Place Standard iPart dialog box

Table Tab
The Table tab (Figure 18-15) displays the iPart table created in the iPart Author dialog box. 
As mentioned earlier, each row in this table represents a part. Also, different fields in the 
rows can be set to different values in the iPart Author dialog box. As a result, you can select 
any row from this tab to insert the iPart. Depending on the value of the parameters defined 
for the selected row in the iPart Author dialog box, the part will be placed.

Figure 18-15  The Table tab of the Place Standard iPart dialog box

Placing Custom iParts in an Assembly
To place a part using the custom iPart factory, invoke the Place tool. Next, select the custom 
iPart and choose the Open button; the Place Custom iPart dialog box will be displayed. The 
options in the three tabs of this dialog box are discussed next.

Keys Tab
The Keys tab of the Place Custom iPart dialog box (Figure 18-16) has two panes. The 
pane on the left is the Predefined values pane and displays all the parameters that 
were not made custom in the iPart Author dialog box. Note that you cannot modify 
the values of the parameters available in this pane. The pane on the right is called the 
Custom values pane. It displays all the parameters that were made custom using the iPart 
Author dialog box. To modify the value of the parameter, click on the Value field of that 
parameter in the Custom values pane; the field will change to an edit box. Enter the new 
value in it. The part that will be placed using this iPart factory will have the specified value 
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of the parameter.

Figure 18-16  The Keys tab of the Place Custom iPart dialog box

Tree Tab
The Tree tab (Figure 18-17) also has two panes. The left pane displays the name and values 
in the form of a tree view of the parameters that were assigned keys in the iPart Author 
dialog box. The right pane displays the parameters that were made custom using the iPart 
Author dialog box. 

Figure 18-17  The Tree tab of the Place Custom iPart dialog box

Table Tab
The Table tab of the Place Custom iPart dialog box (Figure 18-18) is similar to that of the 
Place Standard iPart dialog box. It displays the iPart table that was created in the iPart 
Author dialog box. You can select the table to place the part based on the values in that table.

Figure 18-18  The Table tab of the Place Custom iPart dialog box
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Changing the iParts in the Assembly File
If the iPart factory used to place the iPart in the assembly file has more than one row in the iPart 
table, you can replace the iPart with the other iPart defined in the rows. To change the iPart, 
right-click on Table under iPart in the Browser Bar; a shortcut menu will be displayed. Choose 
Change Component from the shortcut menu; the Place Standard iPart dialog box or the Place 
Custom iPart dialog box will be displayed. Choose the Table tab and then select the row of 
the required iPart; the previous iPart will be replaced by the other iPart whose row you select.

CREATING 3D SKETCHES
 Ribbon:	 3D Model > Sketch drop-down > Start 3D Sketch 

In earlier chapters, you have learned to create 2D sweeps by defining path in 2D space. 
In this chapter, you will learn to create a 3D sketch that can be used for creating sweep 
features in 3D environment, as shown in Figure 18-19.

To create a 3D sketch, choose the Start 3D Sketch tool from the Sketch drop-down in the Sketch 
panel of the 3D Model tab; the 3D sketching environment will be activated. Note that because 
a 3D sketch has to be created, you will not be prompted to select the sketching plane. As soon 
as you enter the 3D sketching environment, the 3D Sketch tab will be activated. Some of the 
tools in this tab are the same as those discussed in 2D sketching. The functions of the remaining 
tools are discussed next.

Line
The Line tool is used to create a line in the 3D space. Note that similar to drawing a 
line in a 2D sketch, you can create a line by specifying the points on the graphics screen. 
The 3D line can also be created by using work points, vertices of an existing model, or 
center points of a cylindrical feature or hole. You can also turn on the option of creating 

bends at the corners of a 3D line. By default, this option is turned off. To turn this option on, 
invoke the Line tool in the 3D sketching environment and then right-click in the drawing window 
to display the Marking Menu. Choose the Auto-Bend option. Now, when you draw a 3D line, 
it will automatically be bent at the corners and the bend radius will be displayed, as the value 
of the first instance. At the remaining instances, the value will be displayed as a function of the 
first value. As a result, when you modify the first value, the remaining values will be modified 
automatically. If you want to modify any other value, double-click on it and modify it using the 
Edit Dimension edit box. However, in this case, the modified value will no more be the function 
of the first value. Figure 18-20 shows a 3D line created by using the vertices of an existing model 
and the center points of the holes. 
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Figure 18-19  Pipe created by sweeping a profile 
along a 3D path 

Figure 18-20  3D line created using work points 
and vertices of a model

Spline
The Spline tool is used to create splines in the 3D sketching environment. This tool 
works similar to the Spline tool of  2D sketching environment. You can use work 
points, vertices of an existing feature, or center points of holes or cylindrical features 
for creating a 3D spline.

Bend
The Bend tool is used to create bends manually at the

Figure 18-21  The Bend 
dialog box

 
corners of the 3D line. When you invoke this tool, the 

Bend dialog box will be displayed, as shown in Figure 18-21. You can 
specify the radius of the bend in this dialog box and then select the 
two lines that comprise of the corner where the bend will be created. 
Note that if a cross is displayed on placing the cursor over the lines, 
it suggests that the lines can not be selected for creating a bend.

Include Geometry
The Include Geometry tool is used to include an existing 2D geometry in the 3D 
sketch. You can also select an edge of an existing model to be included in the 3D sketch. 
This is similar to projecting geometries or cutting edges. The only difference is that 
in this case, the selected entities are projected in a 3D sketching environment.

Intersection Curve
The Intersection Curve tool is used to

Figure 18-22  The 3D Intersection Curve 
dialog box

 
create a 3D curve using the intersection of 
two surfaces, work planes, or existing 
components. When you invoke this tool, 

the 3D Intersection Curve dialog box will be 
displayed, as shown in Figure 18-22.

When you invoke this dialog box, the Select 
intersecting geometry button is chosen by default.  
Select the first intersecting geometry; the Select 
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geometry to be intersected button will be chosen automatically. Now, select the other 
intersecting surface and then choose OK  button; a 3D curve will be created at the 
intersection of the two selected geometries. Figure 18-23 shows two intersecting surfaces 
and Figure 18-24 shows the resultant 3D curve created using the intersecting surfaces.

Figure 18-23  Intersecting surfaces Figure 18-24  3D curve created using the 
surfaces 

Helical Curve
The Helical Curve tool allows you to create 3D helical curves that consist of a helical 
curve and a centerline. The dimensions of the curve are also displayed in the drawing 
area. To create a 3D helical curve, choose the Helical Curve tool from the 3D Sketch 
tab; the Helical Curve dialog box will be displayed, as shown in Figure 18-25. Also, you 

will be prompted to select a start point for the helix axis. The Inventor Precise Input toolbar 
that is displayed along with the Helical Curve dialog box can be used to specify the start point 
and endpoint of the helix axis. The rest of the options that are used to create the helical curve 
are similar to those discussed while creating coil feature in Chapter 8. Figure 18-26 shows a 
helical curve along with other components displayed in the drawing area.
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Figure 18-25  The Helical Curve dialog box Figure 18-26  Helical curve with its 
components

Note
 The other options in this environment are similar to those discussed in the 2D Sketching environment 
and Part modeling environment.

TUTORIALS
Tutorial 1

In this tutorial, you will create new parameters and then use them for sketching and extruding the 
model shown in Figure 18-27. The dimensioned sketch is shown in Figure 18-28. The sketch 
should be extruded upto a distance of EXT. The dimensions in the sketch should be displayed 
as equations, as shown in Figure 18-28.	 	                                (Expected time: 30 min)

The numeric values of parameters are given below.

LEN = 60
WID = LEN/2
RAD = LEN/6
EXT = LEN/3
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Figure 18-27  Model for Tutorial 1 Figure 18-28  Sketch for the model

 	 The following steps are required to complete this tutorial:

a.	 Start Autodesk Inventor and then start a new metric standard part file.
b.	 Create the sketch and add required constraints to it.
c.	 Invoke the Parameters tool and create required parameters.
d.	 Invoke the Document Settings dialog box and select the option to display the dimensions 

as equations.
e.	 Invoke the Dimension tool and dimension the sketch by entering parameters instead of 

entering values in the Edit Dimension edit box.
f.	 Exit the sketching environment and extrude the sketch. Enter the parameters instead of 

entering value in the extrusion distance edit box.

Starting a New Part File
1.	 Start Autodesk Inventor and invoke the Create New File dialog box.

2.	 Choose the Metric and start a new metric part file to invoke the Modeling environment.

3.	 Choose the Start 2D Sketch tool from the Sketch panel of the 3D Model tab; default planes 
are displayed and you are prompted to select the sketching plane.

4.	 Now, select the XY plane as the sketching plane from the graphics window.

Drawing the Sketch
1.	 Draw the sketch for the model by using the sketching tools. Add required constraints to it. 

The sketch after adding the constraints is shown in Figure 18-29.
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Figure 18-29  Sketch after adding required constraints

Creating Parameters
	 As mentioned earlier, parameters are created by using the Parameters dialog box. You can 

invoke this dialog box by using the Parameters tool. 

1.	 Choose the Parameters tool from the Parameters panel of the Manage tab to invoke the 
Parameters dialog box.

2.	 Choose the Add Numeric button from this dialog box to enter a new row in the User 
Parameters table. Enter the name of the parameter as LEN in the Parameter Name field 
and then press ENTER.

	 You will notice that a new row with the name LEN is created. The unit of the parameter is 
mm, and the equation and value is 1. Now, you need to modify the value of the parameter.

Note
Note that the parameter names are case-sensitive. Therefore, if you enter a name in uppercase 
characters, you need to enter the parameters in the same case while specifying them in the Edit 
Dimension edit box or in a dialog box. 

3.	 Click on the Equation field of the LEN row; it changes into an edit box. Enter 60 in this 
edit box and then press ENTER.

	 You will notice that the values of the Nominal Value field and the Model Value field are 
automatically changed to 60.000000.

4.	 Again, choose the Add Numeric button to add another row to the User Parameters table.

5.	 Enter WID in the Parameter Name field.

6.	 Click on the Equation field of the WID row and enter LEN/2 in this field. Next, press 
ENTER.

	 You will notice that the value in the Model Value field has automatically changed to 30.000000. 
This is because the value of the LEN parameter is 60 and WID = LEN/2 = 60/2 = 30. Also, 
notice that ul has automatically been added on the right of the equation. You do not need 
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to enter this value while defining the equation as it is automatically added by Autodesk 
Inventor.

7.	 Similarly, create the remaining parameters. The Parameters dialog box after creating all 
the parameters is shown in Figure 18-30. Choose Done to exit the Parameters dialog box.

As you have not dimensioned the sketch until now, no row will be displayed in the Model 
Parameters table. Once you add dimensions to the sketch, the parameters will automatically 
be added to the Model Parameters table.

Figure 18-30  The Parameters dialog box after adding the user-defined parameters

Displaying Dimensions as Equations
	 As mentioned in the tutorial description, you need to display dimensions as equations. 

Therefore, you need to select this option from the Document Settings dialog box. 

1.	 Choose the Document Settings tool from the Options panel of the Tools tab to invoke the 
Document Settings dialog box.

2.	 In this dialog box, choose the Units tab and select the Display as expression radio button 
from the Modeling Dimension Display area. Next, choose Apply and then choose Close 
to exit the dialog box.

Dimensioning the Sketch
	 Now, you need to dimension the sketch by using parameters. As mentioned earlier, parameters 

are case-sensitive. This means if you have specified the name of the parameter in capital 
letters, you need to enter the name in the Edit Dimension edit box in capital letters only, 
otherwise the Autodesk Inventor dialog box states you that this expression cannot be 
evaluated.

1.	 Invoke the Dimension tool and then select the vertical lines one by one at the two ends of 
the sketch. Place the dimension below the sketch; the Edit Dimension edit box is displayed.
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2.	 Enter LEN in the Edit Dimension edit box and press ENTER.

	 You will notice that the dimension is automatically modified and displayed as an equation 
on the graphics screen. This happens because you have selected the option of displaying 
dimensions as equations. 

3.	 Select the left vertical line and then place the dimension on the left of the sketch; the Edit 
Dimension edit box is displayed. Enter WID in the Edit Dimension edit box and press 
ENTER.

4.	 Select the upper arc and then place the dimension on the left of the arc; the Edit Dimension 
edit box is displayed.  Enter RAD in the Edit Dimension edit box and press ENTER.

	 This completes the dimensioning of the sketch. The sketch after adding all the dimensions 
is shown in Figure 18-31. In this figure, the grid lines and axes have not been displayed for 
better visibility of the sketch.

Note
If you do not dimension the sketch in the same sequence as mentioned above, the names of the 
model parameters with which the user parameters are equated will be different from those shown 
in Figure 18-28.

Extruding the Sketch
1.	 Exit the sketching environment and then change the current view to the isometric view.

2.	 Invoke the Properties-Extrusion dialog box and then enter EXT in the edit box provided 
in the Distance A edit box. Accept the remaining default options and then choose the OK 
button. 

	 The sketch is extruded through a distance defined by the EXT parameter. You can also 
specify the parameters of the extruded feature using the mini toolbar that is displayed on 
invoking the Extrude tool.

3.	 Save the model with the name Tutorial1.ipt at the location given below and then close the 
file.

	 C:\Inventor_2023\c18
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Figure 18-31  Sketch displaying the dimensions as equations

Tutorial 2
In this tutorial, you will create an assembly of the Outer Plate and the Inner Plate shown in 
Figure 18-32. The dimensions of the Outer Plate are shown in Figure 18-33. Create the Inner 
Plate as an adaptive part such that it automatically adjusts its size to fit inside the Outer Plate. 
Apply the Mate constraint with an offset of 10 mm to all the outer faces of the Inner Plate and 
the inner faces of the groove in the Outer Plate. After assembling the components, edit the inner 
cavity of the Outer Plate such that the Inner Plate again automatically adjusts its size.		
					           		                         (Expected time: 1 hr)

Note
As the Inner Plate has to be an adaptive part, its dimensions are not required.

	 The following steps are required to complete this tutorial:

a.	 Start a new metric assembly file and then create the Outer Plate.
b.	 Invoke the Create tool and then select the top face of the Outer Plate as the sketching plane 

for the Inner Plate.
c.	 Make the sketch of the Inner Plate adaptive and then set the parameters in the Assembly 

tab of the Options dialog box.
d.	 Sketch the Inner Plate and then extrude it up to the bottom face of the Outer Plate.
e.	 Save the model and then exit the Part environment.
f.	 Add the Mate constraint between all inner faces of the groove in the Outer Plate and the 

outer faces of the Inner Plate. The size of the Inner Plate automatically changes in order to 
adjust inside the Outer Plate.
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g.	 Modify the dimensions of the inner cavity of the Outer Plate. The size of the Inner Plate 
again changes automatically to retain the design intent.

Figure 18-32  Assembly for Tutorial 2 Figure 18-33   Dimensions of the Outer Plate

Creating the Outer Plate
	 You can directly create the Outer Plate and the Inner Plate in the assembly file. Before 

creating the Outer Plate, you need to change the measurement unit to mm.

1.	 Start a new metric standard assembly file. Next, choose the Create tool from the Component 
panel of the Assemble tab; the Create In-Place Component dialog box is displayed. Enter 
Outer Plate as the name of the component in the New Component Name edit box in this 
dialog box. Next, choose the OK button.

2.	 Choose the Start 2D Sketch tool from the Sketch panel of the 3D Model tab; the default 
planes are displayed and you are prompted to select the sketching plane.

3.	 Choose the Document Settings button from the Options panel of the Tools tab; the 
Document Settings dialog box is displayed. Choose the Units tab and then select millimeters 
from the Length drop-down list in the Units area of this dialog box. Next, choose Apply 
and then close the dialog box.

4. 	 Create the Outer Plate on the top plane. After creating the Outer Plate, return to the 
assembly file. The assembly file after creating the Outer Plate is shown in Figure 18-34. For 
dimensions, refer to Figure 18-33. 
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Figure 18-34  Assembly after creating the Outer Plate

Creating the Inner Plate
	 You will sketch the Inner Plate by selecting the top face of the Outer Plate as the sketching 

plane. Note that the sketch plane should be constrained to the selected face.

1.	 Invoke the Create tool from the Component plane of the Assemble tab. Make sure that 
the Constrain sketch plane to selected face or plane check box is selected in the Create 
In-Place Component dialog box. 

2.	 Enter Inner Plate as the name of the component in the New Component Name edit box 
in the Create In-Place Component dialog box. Choose OK from this dialog box and then 
select the top face of the Outer Plate.

3.	 Invoke the sketching environment by selecting the top face of the Outer Plate as the sketching 
plane. 

4.	 Right-click on Sketch1 in the Browser Bar and then choose Adaptive from the shortcut 
menu displayed; the Inner Plate becomes adaptive and its size gets adjusted automatically 
based on the surrounding 

5.	 Choose the Application Options tool from the Options panel of the Tools tab to display the 
Application Options dialog box. Choose the Assembly tab from this dialog box to display 
the options in this tab.

6.	 Select all the check boxes in the In-place features area to make the model adaptive. As a 
result, on extruding the model up to the bottom face of the Inner Plate, the new part is 
modified automatically.  
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7.	 Choose Apply and then choose Close from the Application Options dialog box. Next, draw 
the sketch for the Inner Plate and then extrude it up to the bottom face of the Outer Plate. 
Save the part file and then exit the part modeling environment.

	 You do not need to add dimensions to the Inner Plate as it is an adaptive part. The assembly 
after creating the Inner Plate is shown in Figure 18-35.

Figure 18-35  Assembly after creating the 
Inner Plate

8.	 Now, apply the Mate constraint with an offset value of 10 mm between the selected faces as 
shown in Figure 18-36; the Inner Plate shifts toward right.

9.	 Change the display type of both plates to Wireframe and then apply the Mate constraint 
with an offset of 10 mm between the selected faces, as shown in Figure 18-37; the Inner 
Plate gets shifted.

Figure 18-36  Faces selected to apply the 
Mate constraint

Figure 18-37  Faces selected to apply the Mate 
constraint 

10.	 Now, change the display type of both the plates to Shaded and apply the Mate constraint 
with an offset value of 10 mm between the selected faces, as shown in Figure 18-38. Also, 
you will see that the size of the Inner Plate is reduced in order to fit inside the cavity of the 
Outer Plate. This is because of the adaptive property of the Inner Plate.



18-30                                 		  Autodesk Inventor 2023 Professional for Designers

11.	 Similarly, apply the Mate constraint with an offset value of 10 mm between the selected 
faces, as shown in Figure 18-39.

	 Notice the size of the Inner Plate. It has further reduced in order to fit inside the cavity of 
the Outer Plate.

12.	 Close the Place Constraint dialog box. The assembly after applying the constraints is shown 
in Figure 18-40. Notice the change in the size of the Inner Plate.

Figure 18-38  Faces selected to apply the Mate 
constraint   

Figure 18-39  Faces selected to apply the Mate 
constraint 

Figure 18-40  Assembly after applying the 
constraints

Modifying Dimensions of the Cavity of the Outer Plate
	 You can edit the dimensions of the cavity of the Outer Plate in the assembly file. Since the 

Inner Plate is an adaptive part, its dimensions will automatically change when the dimensions 
of the cavity are modified.

1.	 Double-click on Outer Plate:1 in the Browser Bar to activate this component. 

2.	 Modify the dimensions of the cavity, as shown in Figure 18-41.
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Figure 18-41  Modified dimensions of the cavity

3.	 Choose Return from the Quick Access Toolbar to exit the sketching environment. You may 
need to add the Return tool to the Quick Access Toolbar if it is not displayed by default.

4.	 Again, choose Return from the Quick Access Toolbar to exit the part modeling environment. 
Next, change the current view to the isometric view.

	 On doing so, you will notice that the dimensions of the Inner Plate are modified in order 
to retain the design intent of the assembly. The assembly after modifying the dimensions of 
the cavity is shown in Figure 18-42. Notice the change in the dimensions of the Inner Plate.

Figure 18-42  Modified assembly
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5.	 Choose the Save button from the Quick Access Toolbar; the Save As dialog box is displayed. 
Browse to the C:\Inventor_2023\c18 location and then enter Tutorial2 as the file name in 
the File name edit box. 

6.	 Choose the Save button from this dialog box; the Save message dialog box is displayed. 
Choose Yes to All from this dialog box to save the individual part files that you have created 
in the assembly environment. Next, choose OK to save the file. 

Tutorial 3
In this tutorial, you will create a Pipe in 3D space, as shown in Figure 18-43a. The views and the 
dimensions of the model are given in Figure 18-43b.					     	
                                                                                                                (Expected time: 30 min)

	 The following steps are required to complete this tutorial:

a.	 Create a 2D sketch consisting of three lines on the XZ plane and then exit the sketching 
environment.

b.	 Define a new work plane normal to the existing sketch and then create the second 2D sketch 
on this new work plane. The start point of the first line in the second sketch should be the 
endpoint of the right vertical line in the first sketch.

c.	 Invoke the 3D sketching environment and then select all lines to be included in the 3D 
sketch using the Include Geometry tool.

d.	 Add bends at all the corners and then exit the 3D sketching environment.
e.	 Define a new work plane at the start point of the path and then sketch the profile of the 

pipe. Take the reference of the start point of the first line for drawing the sketch.
f.	 Exit the sketching environment and sweep the sketch along the 3D path.

Figure 18-43a  Pipe for Tutorial 3
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Figure 18-43b  Pipe for Tutorial 3

Drawing the First 2D Sketch
1.	 Invoke the Create New File dialog box and then choose the Metric tab from it.

2.	 Start a new part file.

3.	 Choose the Start 2D Sketch tool from the Sketch panel of the 3D Model tab; the default 
planes are displayed and you are prompted to select the sketching plane.

4.	 Draw the first sketch on the XZ plane, as shown in Figure 18-44. 

5.	 Exit the sketching environment by choosing the Finish Sketch button.

Drawing the Second 2D Sketch
	 You need to create the second 2D sketch on a work plane that is normal to the third line 

of the first 2D sketch. Therefore, first you need to define a new work plane normal to the 
third line of the sketch.

1.	 Define a new work plane normal to the right vertical line in the sketch and then select it as 
the sketching plane for drawing the next 2D sketch.
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2.	 Draw the next sketch starting from the origin of the sketch plane. The origin of the sketch 
plane is the endpoint of the right vertical line of the first sketch, see Figure 18-45. 

	 To ensure that the start point of the line is at the origin, you need to project the third line of 
the sketch. On doing so, the line will be projected as a point that will be placed at the origin. 
Now, apply the Coincident constraint between the endpoint of the line and the projected 
point. 

3.	 Exit the sketching environment and turn off the display of the work plane. First and second 
2D sketches are shown in Figure 18-45.

Figure 18-45  First and second 2D sketchesFigure 18-44  First 2D sketch

Creating the 3D Sketch
1.	 Choose the Start 3D Sketch tool from 3D Model > Sketch > Sketch drop-down  

to invoke the 3D Sketching environment.

2.	 Choose the Include Geometry tool from the Draw panel of the 3D Sketch tab.    

3.	 Select one by one all the lines in the first 2D sketch and the second 2D sketch.

4.	 Choose the Bend tool from the Draw panel of the 3D Sketch tab to display 
the Bend dialog box. Enter 10 in the Radius edit box and then select all the 
lines that form the corners of the 3D sketch.

	 You will notice that a fillet kind of bend is created at all the corners of the 3D sketch and 
the dimension is displayed on all the bends. 

5.	 Exit the 3D sketching environment. 

6.	 Now, turn off the visibility of the two 2D sketches using the Browser Bar. The 3D sketch 
after turning off the visibility of the 2D sketches is shown in Figure 18-46.
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Note
If you are not able to fillet the vertex at the intersection of the first and second 2D sketches, it implies 
that the endpoint of the first 2D sketch is not coincident with that of the second 2D sketch. In other 
words, the start point of the first line of the second 2D sketch is not at the origin. Therefore, you 
need to edit the second 2D sketch and move it to the origin.

 
Creating the Profile for the Sweep Feature	
	 To create the profile for the sweep feature, you need to define a new work plane at the start 

point of the first 2D sketch. Next, you need to select this work plane as the new sketching 
plane and draw the sketch of the profile. 

1.	 Define a new work plane at the start point of the 3D path from where the first 2D sketch  
was started. Select this work plane as the new sketching plane.

2.	 Draw the 2D sketch of the profile of the sweep feature. The sketch of the profile consists of two 
concentric circles. The center of the circles should be at the start point of the first line of the 3D 
path. Specify 6 mm as the diameter of the outer circle and 4 mm as the diameter of the inner circle. 

3.	 Exit the sketching environment.

Sweeping the Profile along the 3D Path
1.	 Invoke the Properties-Sweep dialog box and select the area between the two circles as the 

profile of the sweep feature; the area between the two circles turns blue and the selected 
sketch of the profile gets displayed in the Profiles display box.

2.	 Click on the Path display box in the Properties-Sweep dialog box and select the 3D path 
as the path of the sweep feature; the complete 3D path turns blue.

3.	 Choose OK to close the Properties-Sweep dialog box. The final pipe for Tutorial 3 is shown 
in Figure 18-47.

Figure 18-47  Pipe for Tutorial 3Figure 18-46  3D Sketch after turning off the 
visibility of the 2D sketches

4.    Now, turn off the visibility of work plane 2 by using the Browser Bar.

5.	 Save this model with the name Tutorial3 at the location C:\Inventor_2023\c18.
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Tutorial 4
In this tutorial, you will open the model saved in Tutorial 1 and add another parameter to it with 
the name FILLET, where FILLET = LEN/10. Using this parameter, you will fillet the model. 
Figure 18-48 shows the final filleted model. Next, you will change this model into a custom 
iPart factory. Make the LEN and FILLET as custom variables, and then suppress the FILLET 
variable. Finally, place the two iParts in an assembly file using the custom iPart factory that you 
created. The details of the two iParts that you need to place in the assembly are given below.	
							                          (Expected time: 30 min)

iPart 1
Value of LEN = 60
Suppress the fillet in the model

iPart 2
Value of LEN = 100	     

Figure 18-48  Model after filleting the edges using the FILLET parameter

	 The following steps are required to complete this tutorial:

a.	 Open the Tutorial1.ipt file and save it with the name Tutorial4.ipt.
b.	 Create a new user-defined parameter, FILLET in the part. The value of this parameter is 

LEN/10.
c.	 Fillet the model using the FILLET parameter.
d.	 Invoke the iPart Author dialog box and make the LEN parameter custom.
e.	 Add one more row to the iPart table. Change the value of the LEN parameter to 100.
f.	 Invoke the Suppression tab and suppress the FILLET variable.
g.	 Make the FILLET variable custom.
h.	 Save the file and then open a new assembly file.
i.	 Place iParts in an assembly file using the custom iPart factory created earlier. 
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Opening the Tutorial 1 File
1.	 Open the Tutorial1.ipt file created earlier in this chapter. 

2.	 Next, save it with the name Tutorial4.ipt.

Adding a User-defined Parameter
	 You need to add a User-defined Parameter to the current file. This parameter will be used 

to fillet the model. 

1.	 Choose the Parameters tool from the Parameters panel of the Manage tab to invoke  
the Parameters dialog box.

2.	 Choose the Add Numeric button to enter a new row in the User Parameters table. Enter 
FILLET in the Parameter Name field and then press ENTER.

	 Notice that a new row of the user-defined parameter is added. At this stage, the value of this 
parameter is 1.00 mm in the Equation column. Now, you need to equate this parameter in 
terms of the LEN parameter.

3.	 Click on the Equation field in the FILLET row; an edit box replaces the field.

4.	 Enter LEN/10 in the edit box and then press ENTER. You will notice that the value of this 
parameter automatically changes to 6.000000 in the Nominal Value and Model Value edit 
boxes.

5.	 Choose the Done button to exit the Parameters dialog box.

Adding a Fillet to the Model Using the FILLET Parameter
1.	 Choose the Fillet tool from the Modify panel of the 3D Model tab to invoke the Fillet dialog 

box.

2.	 Select the four edges to be filleted from the

Figure 18-49  Rotated view of filleted model

 
model.

3.	 Enter FILLET in the Radius field of the 
Constant tab in the Fillet dialog box. 

	 Note that when you enter values in terms 
of parameters, you need to delete mm 
from the edit boxes.

4.	 Choose OK; the fillet is added to the 
model and the model looks similar to the 
one shown in Figure 18-49.
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Creating the Custom iPart Factory
	 Next, you need to create the custom iPart factory. You will create it by customizing the LEN 

parameter and suppressing the fillet feature.

1.	 Choose the Create iPart tool from the Author panel of the Manage tab; the iPart Author 
dialog box is displayed with the Parameters tab chosen.

	 You will notice that all the user-defined parameters are displayed on the Selected Parameters 
pane. You will also notice that only one row is available in the iPart table. This row has default 
values for the variables.

2.	 Right-click on the LEN variable in the iPart Table; a shortcut menu is displayed. Choose 
Custom Parameter Column from the shortcut menu.

	 You will notice that the LEN column in the iPart Table turns blue and the key on the left 
of this parameter in the Selected Parameters pane is removed.

3.	 Click on the key corresponding to the WID parameter; a key with numeric value 1 is assigned 
to the WID parameter.

4.	 Choose the Suppression tab and then select Fillet1 from the Model Features pane. Choose 
the Add button (>>) to add this feature to the Selected Features pane.

5.	 Next, right-click on Fillet1 in the iPart Table, and then choose Custom Parameter Column 
from the shortcut menu; this feature is made custom. Now, you can suppress or compute it 
while inserting iParts using this iPart factory. Choose the OK button from the iPart Author 
dialog box to create the iPart factory. Now, you can save it and use it to place iParts.

6.	 Choose the Save button from the Quick Access Toolbar and then close this file.

Placing iParts Using the Custom iPart Factory
	 Generally, iParts are placed in the assembly files. Therefore,  you need to start a new assembly 

file to place iParts in it.

1.	 Start a new assembly file and then invoke the Place tool from the Component panel of the 
Assemble tab; the Place Component dialog box is displayed.

2.	 Select the Tutorial4.ipt file from this dialog box to place the iPart and then choose the Open 
button; the Place Custom iPart dialog box is displayed.

	 The Predefined values pane shows only the WID parameter because only this parameter 
was assigned the key. On the other hand, the Custom values pane shows the LEN parameter 
and the Fillet1 feature. As a result, you can modify the value of the LEN parameter and 
suppress or compute the Fillet1 feature.

3.	 Click on the Value field of the Fillet1 feature in the Custom values pane; an edit box replaces 
the field.
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4.	 Select Suppress from this drop-down list. Next, click anywhere on the screen to place the 
component.

5.	 Choose OK to close the dialog box.

Notice that an iPart is placed in the assembly file and the fillet in this part is suppressed.

Tip
If you want to unsuppress fillet in the iPart placed in the current assembly file, click on the  
sign located on the left of the part in the Browser Bar; the tree view expands, and Table and 
Origin appear in the Browser Bar. Next, right-click on the Table, and then choose Change 
Component from the shortcut menu; the Place Custom iPart dialog box will be displayed. 
Change Suppress to Compute in the Value field of Fillet1. Choose OK to exit the dialog box; 
the fillet will be computed and then shown in the model.

6.	 Next, you need to place another iPart with a different value in the assembly. Invoke the 
Place tool to display the Place Component dialog box. 

7.	 Next, select the Tutorial4.ipt in this dialog box to place the iPart and choose the Open button 
from it; the Place Custom iPart dialog box is displayed. Click on the Value field of the LEN 
parameter; the field changes into an edit box.

8.	 Enter 100 in this edit box and then click anywhere on the graphics screen. Next, right-click, 
and then choose OK from the shortcut menu displayed; the component is placed and the 
dialog box is closed. 

9.	 Next, save the file.

	 You can now use these components to create an assembly.

Tutorial 5
In this tutorial, you will use the hybrid surface-solid modeling to create the model shown in 
Figure 18-50. Figure 18-51 shows the dimensions of this model.					   
                                                                                                              (Expected time: 45 min)
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Figure 18-50  Model for Tutorial 5

Figure 18-51  Views and dimensions of the model
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	 The following steps are required to complete this tutorial:

a.	 Open a new part file and then create the sketch on the default XZ plane.
b.	 Revolve this sketch through an angle of 180-degree so that the final output is a surface.
c.	 Create two extruded surfaces.
d.	 Split surfaces using the Face Split option.
e.	 Delete faces using the Delete Face tool.
f.	 Define a new work plane at an offset distance of 45 mm and then create the sketch.
g.	 Split the base surface using the last sketch, and then delete the face.
h.	 Create a 3D sketch on the deleted face and then share the sketch that was used in splitting the 

base surface. Create a lofted surface using the shared sketch and the 3D sketch.
i.	 Create a boundary patch to close the top face of the lofted surface.
j.	 Stitch all surfaces together and fillet all sharp edges.
k.	 Thicken the surface using the Thicken/Offset tool.

Creating the Base Surface
	 You will create the base surface using the sketch drawn on the XZ plane. Next, you will 

revolve this sketch by an angle of 180 degrees.

1.	 Open a new metric standard part file and then choose the Start 2D Sketch tool from the 
Sketch panel of the 3D Model tab; the default planes are displayed and you are prompted 
to select the sketching plane. 

2.	 Draw the sketch on the XZ plane, as shown in Figure 18-52. Constrain the sketch fully by 
specifying dimensions and geometric constraints. 

3.	 Exit the sketching environment and then invoke the Revolve tool from the Create panel of 
the 3D Model tab; the Properties-Revolution dialog box will be displayed. 

	 Select the sketch from the drawing area if not already selected; you are prompted to select 
the axis.

4.	 Select the centerline as the axis of revolution; preview of the resultant surface is displayed.

5.	 Enter 180 in the Angle edit box in the Behavior node. Next, choose OK; the base surface 
is created, as shown in Figure 18-53.
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Figure 18-52  Fully constrained sketch for the base surface

Figure 18-53  Base surface

Creating Side Surfaces
	 You need to create two cuts on both sides of the base surface by splitting the base surface 

using the two surfaces at sides. Therefore, first you need to create side surfaces.

1.	 Define a new sketch plane on the XZ plane and then create an ellipse, as shown in 
Figure 18-54. Note that the center point of the ellipse should be coincident with the edge 
of the base surface. 

	 Next, you need to extrude the ellipse to create the surface.
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2.	 Exit the sketching environment and then extrude the ellipse as a surface through a distance of 
30 mm.

3.	 Choose the Mirror tool from the Pattern panel of the 3D Model tab; the Mirror dialog box 
is displayed and you are prompted to select a feature to pattern.

4. 	 Select the extruded elliptical surface and then select XY Plane as the mirror plane. Next, 
choose OK from the Mirror dialog box; the feature is mirrored, as shown in Figure 18-55.

Figure 18-54  Ellipse created on the XY plane Figure 18-55  Model after creating the mirror 
feature

Creating Cuts on Sides by Using Side Surfaces
	 To create cuts on the sides, first you will use the two side surfaces to split the base surface. 

Next, you will use the base surface to split the side surfaces. Finally, all the unwanted surfaces 
will be deleted using the Trim tool.

1.	 Invoke the Trim Surface tool from the Surface panel of the 3D Model tab and select one 
of the extruded elliptical surfaces as the cutting tool.

2.	 Select the portion common between the base surface and the extruded surface as the portion 
to be trimmed, as shown in Figure 18-56. Choose OK from the dialog box.

3.	 Trim the revolved base surface using the second extruded surface as the cutting tool.

4.	 Using the base surface as the cutting tool, trim the remaining portion of the extruded surface 
on the left of the base surface, as shown in Figure 18-57.

5.	 Trim the other extruded elliptical surface using the base surface as the trim tool. Note that 
you need to select the outer portion of the extruded surface to trim, as shown in Figure 18-58.

 
	 The model after trimming all the unwanted surfaces is shown in Figure 18-59.
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Figure 18-56  Trimming the base surface Figure 18-57  Trimming one of the extruded 
surfaces

Figure 18-58  Trimming the other extruded 
surface

Figure 18-59  Model after trimming 
unwanted surfaces

Creating the Lofted Surface
	 Next, you need to create the lofted surface. 

Figure 18-60  Sketch drawn on the offset plane

To create this surface, you need to create 
a work plane at an offset from the XZ 
plane.

1.	 Create a new work plane at an offset 
distance of 45 mm above the XZ plane. 

2.	 Select this plane as the sketching plane and 
draw the sketch, as shown in Figure 18-60.

3.	 Exit the sketching environment and invoke 
the Split tool from the Modify panel of the 
3D Model tab. 

4.	 Select the sketch as the split tool and select 
the base surface as the face to be split. 
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5.	 Choose the OK button from the Split dialog box; the base surface is split using the sketch.

6.	 Delete the split surface from the base surface using the Delete Face tool. The model after 
deleting the split surface is shown in Figure 18-61.

	 Next, you will create a 3D sketch using the edges of the surface that are removed from the 
base surface.

7.	 Invoke the 3D sketching environment and then choose the Include Geometry tool from 
the Draw panel of the 3D Sketch tab. 

8.	 Select the four edges that resulted from the split surface which was removed from the base 
surface, see Figure 18-62.

Figure 18-61  Model after deleting the split surface Figure 18-62  3D Sketch created using edges

9.	 Exit the 3D sketching environment.
 
10.	 Turn on the visibility of the sketch that was used to split the base surface, refer to Figure 18-60.

11.	 Create a lofted surface between the two sketches.

12.	 Turn off the visibility of the sketches. The model after creating the lofted surface is shown 
in Figure 18-63.

	 Next, you need to cover the top face of the lofted surface using the Patch tool.

13.	 Choose the Patch tool from the Surface panel of the 3D Model tab to invoke the 
Boundary Patch dialog box. 

14.	 Select the top edges of the lofted surface and choose OK from the Boundary Patch dialog 
box; a boundary patch covering the top of the lofted surface is created, see Figure 18-64.
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Figure 18-63  Model after creating the lofted 
surface

Figure 18-64  Model after covering the top 
face of the lofted surface

Stitching Surfaces and Hiding Original Surfaces
	 After creating all the surfaces, you need to stitch them together and hide the original surfaces. 

The surfaces will be stitched using the Stitch Surface tool.

1.	 Invoke the Stitch Surface tool from the Surface panel of the 3D Model tab. Select all the 
surfaces so that they get stitched together. Next, choose Apply and then Done from the 
Stitch dialog box. Figure 18-65 shows the model after stitching surfaces.

	 When you stitch the surfaces, a stitched surface is created above the original surfaces and 
the visibility of original surfaces is automatically turned off.

2.	 Fillet all the sharp edges of the stitched surface with a radius of 2 mm. The surface after 
creating fillets is shown in Figure 18-66. 

Figure 18-65  Model after stitching surfaces Figure 18-66  Model after filleting surfaces

Thickening the Surface
	 The final step in creating the hybrid surface-solid model is to thicken the complex surface 

created in the previous steps. By thickening, you can add material to the surface model so 
as to make it a solid model. The model can be thickened using the Thicken/Offset tool.
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1.	 Invoke the Thicken/Offset tool from the Modify panel of the 3D Model tab; the 
Properties-Thicken dialog box is displayed. Select the Quilt selection toggle button from 
it.

2.	 Set the value in the Distance edit box in the Behavior area to 1 if not already set. Select the 
stitched surface. 

	 Select the Quilt selection toggle button, you will notice that the entire stitched surface is 
selected in a single click.

3.	 Choose OK to exit the dialog box. Now, turn off the visibility of the stitched surface using 
the Browser Bar. The final model for Tutorial 5 is shown in Figure 18-67. Figure 18-68 
shows the rotated view of the same model.

Figure 18-67  Final hybrid model Figure 18-68  Rotated view of the hybrid model

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 The options in the __________ tab of the iPart Author dialog box are used to add thread 
parameters to the iPart factory.

2.	 __________ parameters are automatically created when you apply dimensions to entities or 
create a feature.

3.	 __________ are mathematical expressions in which parameters are equated with algebraic 
or trigonometric functions.

4.	 The dimensioning of __________ parts is changed automatically depending upon the 
dimensions and functions of other parts to which they are assembled.

5.	 In Autodesk Inventor, every dimension is assigned a unique name called __________.

6.	 The __________ tool is used to create bends manually at the corners of the 3D line.
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7.	 Autodesk Inventor allows you to create custom and standard iParts. (T/F)

8.	 You cannot turn off the display of surfaces. (T/F)

9.	 In Autodesk Inventor, the hybrid surface-solid modeling is used to create complex surfaces. 
(T/F)

10.	 Autodesk Inventor does not allow you to display dimensions as equations. (T/F)

 Review Questions 
Answer the following questions:

1.	 Which of the following tabs in the iPart Author dialog box is used to select the parameters 
and dimensions to be included in the iPart factory?

		  (a) Parameters			   (b) Threads
		  (c) Work Plane			   (d) None of these

2.	 Which of the following is not a parameter?

		  (a) Drawing			   (b) Model
		  (c) User				   (d) Link

3.	 Which of the following tabs in the Document Settings dialog box is used to display dimensions 
as equations?

		  (a) Units			   (b) Sketch
		  (c) Modeling			   (d) None of these

4.	 Which of the following tabs in the iPart Authors dialog box is used to specify whether the 
selected features will be computed or suppressed while creating a part using the iPart factory?

		  (a) Parameters			   (b) Threads
		  (c) Work Plane			   (d) Suppression

5.	 Which of the following tools is used to merge a 2D sketch entity into a 3D sketch?

		  (a) Line				   (b) Bend
		  (c) Include Geometry		  (d) None of these

6.	 You can modify dimensions while inserting custom iParts in an assembly. (T/F)

7.	 You can specify sketch points using the Inventor Precise Input toolbar in the 3D sketching 
environment. (T/F)

8.	 Unlike the 2D sketching environment, you can save a file in the 3D sketching environment. 
(T/F)
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9.	 The Link parameters are created in a separate Microsoft Excel spreadsheet. (T/F)

10.	 The User parameters are defined by the user for specifying the dimensions of entities and 
features. (T/F)

EXERCISES
Exercise 1

Create the following sketch with the help of parameters. After dimensioning the sketch, display 
the dimensions as expressions, as shown in Figure 18-69. The numeric values of the parameters 
are given below.					     		         (Expected time: 30 min)

LEN = 60
LEN1 = LEN/3
LEN2 = LEN/2.5
WID = LEN*0.75
WID1 = WID/5
WID2 = WID1

After displaying the dimensions as expressions, display them as names.

Figure 18-69  Sketch with dimensions as equations
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Answers to Self-Evaluation Test
1. Threads, 2. Model, 3. Equations, 4. adaptive, 5. parameter, 6. Bend, 7. T, 8. F, 9. T, 10. F


